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số người có chuyên môn về Linux ở trang www.vnlinux.org. Xin cảm ơn những người sau đây:
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Đây là một tài liệu miễn phí. Bạn hoàn toàn có thể phân phối nó lại cho những người sử dụng
khác hoặc có thể chỉnh sửa cho phù hợp nhưng phải tuân theo những yêu cầu trong giấy phép bản
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1 Giới thiệu chung

Linux là một hệ điều hành. Về mặt nguyên tắc hệ điều hành cũng là một ứng dụng máy tính;
nhưng đây là một ứng dụng đặc biệt – được dùng để quản lý, điều phối các tài nguyên của
hệ thống (bao gồm cả phần cứng và các phần mềm khác). Linux được phát triển bởi Linus
Torvalds, dựa trên hệ điều hành Minix - một hệ điều hành có cấu trúc tương tự Unix với các
chức năng tối thiểu được dùng trong dạy học.

Linux là một hệ điều hành với các khả năng đa nhiệm, đa tác vụ, đa người dùng. Sau hơn
mười năm phát triển, Linux đã chứng tỏ là một hệ điều hành uyển chuyển (có thể hoạt động
trên nhiều loại phần cứng), đáng tin cậy và ổn định. Hiện nay, Linux trở thành hệ điều hành
với mã nguồn mở và miễn phí dưới bản quyền của tổ chức GNU (Gnu’s Not Unix). Linux đang
là đe doạ lớn nhất đối với Microsoft Windows khi rất nhiều các tổ chức chính phủ và xí nghiệp
trên thế giới tuyên bố đoạn tuyệt với Windows để chuyển sang dùng Linux.

Hệ điều hành Linux được dùng trong hầu hết hệ thống máy chủ của các trường đại học,

cao đẳng Nhật Bản. Ở đây chúng tôi chỉ giới thiệu về Linux và những thao tác cơ bản nhất
liên quan đến hệ điều hành này.

Tài liệu này nằm trong khuôn khổ dự án Xoá mù Linux, dành cho đối tượng là các sinh
viên Việt Nam đang học tiếng Nhật tại Tokyo chuẩn bị về trường học chuyên môn.

1.1 Một số phiên bản Linux

Redhat và Fedora Core Bản Linux có lẽ là thịnh hành nhất trên thế giới, phát hành bởi
công ty Redhat. Từ năm 2003, Redhat Inc. chuyển hướng kinh doanh. Họ đầu tư phát triển
dòng sản phẩm Redhat Interprise Linux (RHEL) với mục đích thương mại, nhắm vào các công
ty, xí nghiệp. Đối với người dùng bình thường, họ open một project tên là Fedora. Redhat bỏ
tiền và một số kỹ sư của mình hỗ trợ cho dự án này đồng thời kêu gọi developers trên khắp thế
giới qui tụ lại để phát triển Fedora Core. Bản Linux của Redhat cuối cùng dừng ở phiên bản
9.0. Version của Fedora Core được đếm từ 1. Có thể nghĩ đại khái là FC1 tương đương Redhat
10, FC2 tương đương Redhat 11. Thực tế thì khác nhiều, đặc biệt là từ FC2.

WhiteBox Linux Bản clone của Redhat Enterprise Linux 3.0. Build trên source code của
RHEL bởi một nhóm các kỹ sư ở LA, Hoa Kỳ. Hiện nay server Nhatban.NET đang dùng bản
này.

SuSE Linux Made in Germany. Bản Linux cực kỳ thịnh hành ở châu Âu và Bắc Mỹ. Năm
2003, công ty SuSE bị ông lớn Novell mua. Novell đang dốc sức đầu tư cho SuSE để nhắm vào
enterprise users hòng giành lại thị phần từ tay Redhat. Bản SuSE mới nhất hiện nay là 9.1

Mandrake Linux Made in France. Cũng là một bản Linux rất thịnh hành ở châu Âu, Mỹ,
và Việt Nam. Đây cũng là bản được ưu ái nhất trong vấn đề Việt hoá. Theo thông tin mới nhất
ngày 22/7/2004 thì quá trình Việt hoá cho Mandrake Linux (MDK) đã đạt 85%. Bản MDK
mới nhất hiện nay là 10.0

Turbo Linux Nổi tiếng ở Nhật, Trung Quốc. Công ty Turbo đang đầu tư mạnh nhằm thống
trị thị trường Linux Trung Quốc. Bản Turbo mới nhất hiện nay là 10F
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Debian Linux Một ông lớn nữa trong làng Linux. Nhiều người có ý kiến cho rằng: người
không chuyên nên dùng Fedora Core để có thể làm quen được với những kỹ thuật mới nhất
của Linux, còn dân chuyên nghiệp nên dùng Debian vì sự ổn định tuyệt vời của nó. Bản mới
nhất: 3.0R2

Vine Linux Cực kỳ được ưa chuộng tại Nhật. Được phát triển trên nền Redhat 6.2. Đặc
điểm của bản này là rất nhẹ (duy nhất 1 đĩa CD) và hỗ trợ tiếng Nhật 100%. Vine Linux cũng
được tích hợp thêm một số tính năng của Debian ví dụ như apt-get. Bản mới nhất hiện nay là
2.6R4. Bản 3.0 sẽ được release trong tháng 8/2004.

Knoppix Linux Made in Germany. Bản live Linux được ưa chuộng nhất hiện nay. Khởi động
trực tiếp từ CD mà không cần cài đặt vào ổ cứng. Phiên bản mới nhất là 3.4

Vietkey Linux Made in Vietnam. Hoàn toàn không có tiếng tăm gì ngoài chuyện được giải
trong cuộc thi TTVN 2003. Phát triển bởi nhóm Vietkey trên nền Redhat 7.2. Cũng nên thử
cho biết sản phẩm đoạt giải nhất của TTVN nó ra sao.

vnlinuxCD Bản live CD by Larry Nguyễn. Nguyên tắc của vnlinuxCD giống Knoppix nhưng
được build trên nền Mandrake 9.2. Hỗ trợ khá tốt các vấn đề về tiếng Việt.

Các phiên bản khác Còn rất nhiều distributor khác. Các bạn tự tìm hiểu thêm. Check:
Slackware, Gentoo, College, Yellow Dog, SGI, Momonga,...
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2 Cài đặt Fedora Core 2

2.1 Yêu cầu

Để có thể thực hiện hết những gì ghi trong bản hướng dẫn này, hệ thống của bạn cần thoả
mãn những yêu cầu sau:

� Máy của bạn phải khởi động được từ ổ CD/DVD

� Ổ cứng của bạn phải còn dư ít nhất 6GB

� Ít nhất 128MB RAM

� Đường truyền internet tốc độ cao (ADSL hoặc cáp quang)

2.2 Chuẩn bị

Trước khi cài đặt, cần chuẩn bị những thứ sau:

1. Chuẩn bị sẵn 1 đĩa DVD hoặc 4 đĩa CD FC2

2. Dùng Partition Magic (trên Windows) hay một chương trình chia ổ đĩa nào đó tạo sẵn
một partition lớn khoảng 6 đến 8 GB, format dạng nào cũng được (fat, fat32, ext3, v.v.).
Từ đây chúng tôi giả định trên máy của bạn có ổ C cài Windows, ổ D format dạng FAT32
để chứa dữ liệu, ổ E trống để chuẩn bị cài FC2

3. Chỉnh sửa BIOS sao cho máy có thể khởi động từ ổ CD/DVD

4. Download gói xmlinux.tbz từ http://vcsj.net/xmlinux.tbz, để ở ổ D

2.3 Cài đặt

Phần này không trình bày thì lại bảo không chu đáo, trình bày kỹ quá thì sẽ bị nói là rỗi hơi.
Tức là cài đặt FC2 dễ như ăn kem ấy, cứ theo chỉ dẫn trên màn hình là xong! Thế này nhé:

1. Nhét đĩa CD hoặc DVD vào, khởi động lại máy

2. Khi boot vào CD/DVD rồi thì Enter một cái để bắt đầu cài, sẽ hiện ra một cái màn hình
Welcome to Fedora Core. Nhấn Next.

3. Language Selection: English

4. Keyboard Configuration: Japanese

5. Monitor Configuration: Để nguyên như mặc định

6. Upgrade Examine: Install Fedora Core

7. Installation Type: Custom

8. Disk Partitioning Setup: Manually partition with Disk Druid

5

http://vcsj.net/xmlinux.tbz
QuanTriMang.com
http://www.QuanTriMang.com



9. Disk Setup: Mục này phải làm thật thận trọng nếu không toàn bộ ổ cứng sẽ bị format
hết! Phần đĩa tương đương với ổ C để nguyên. Phần đĩa tương ứng với ổ D thì nhấn chuột
vào đó rồi nhấn nút “Edit”, trong hộp Mount Point nhập “/data”. Làm như vậy sau này
sẽ dùng ổ D chung với Windows được. Cuối cùng là tới phần đĩa tương ứng với ổ E. Nhấn
chuột lên đó. Nhấn nút “New”. Chọn Mount Point là “/boot”, File System Type là “ext3”,
Size (MB) là 100. Nhấn OK. Nhấn nút “New” một lần nữa. File System Type: “swap”,
Size (MB): 512 (khoảng gấp đôi RAM). OK. Nhấn nút “New” lần cuối. Mount Point: “/”,
File System Type: “ext3”, Addition Size Options: Fill to maximum allowable size (dùng
hết toàn bộ phần đĩa còn lại, cỡ 5000 đến 7000 MB). Next.

10. Boot Loader Configuration: Có thể lựa chọn Windows (DOS) hoặc FC2 làm hệ điều hành
mặc định khi khởi động máy. Để nguyên “Fedora Core”. Next

11. Network Configuration: Next

12. Firewall Configuration: Next

13. Additional Language Support: Chọn English (USA) và Japanese. Select the default lan-
guage for the system: English (USA)

14. Time Zone Selection: Asia/Tokyo (nhấn chuột vào thủ đô Tokyo trên bản đồ)

15. Set Root Password: Nhập password cho root (root là user đặc biệt, có quyền tối cao đối
với hệ thống). Next

16. Package Installation Defaults: Customize software packages to be installed

17. Package Group Selection: Everything (cài tất cả, ổ cứng rẻ bèo, tiếc gì mấy GB :)

18. About to Install: Next

19. Các bước còn lại cứ để như mặc định và nhấn Next. (Nó hỏi có tạo đĩa mềm khởi động
hay không, trả lời là không). Có thể mất 30 tới 60 phút. Trong thời gian đó ra làm ly cà
phê, mệt quá rồi...

20. Cài xong rồi! Máy tự khởi động lại. Hoàn thành nốt các bước còn lại theo chỉ dẫn tên màn
hình. Khi tạo user mới thì nhập tên user và password, chú ý là tên user để chữ thường và
không có dấu cách. Ví dụ: penguin, tuxedo, musketeer,... Từ nay trở đi sẽ login vào máy
bằng account vừa tạo, chỉ dùng account “root” trong những trường hợp đặc biệt.
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3 Làm quen

Từ đây trở đi sẽ dùng một account giả định là “penguin”, các bạn hãy thay thế “penguin” bằng
account thật của mình.

Như mặc định, sau khi khởi động vào FC2, bạn sẽ gặp màn hình như dưới đây:

Bạn nhấn vào cái mũ đỏ (Redhat) và chọn các ứng dụng từ trong đó. (Cái mũ đỏ tương đương
với Start Menu của Windows) FC2 cung cấp hơn 1,000 ứng dụng các loại - tất cả đều miễn phí.

Từ nay bạn sẽ phải dùng nhiều tới một chương trình tên là “Terminal”, hãy tạo một icon
link đến “Terminal” theo cách sau: Nhấn chuột phải lên một vùng trống của thanh công cụ,
chọn Add to Panel → Launcher from menu → System Tools → Terminal

Làm quen với Terminal

Nhấn chuột trái vào icon Terminal trên thanh công cụ hoặc chọn từ Redhat → System Tools
→ Terminal

Thực hiện một số lệnh như:

touch foo.txt : tạo một blank file tên là “foo.txt”

mkdir bin : tạo thư mục tên là “bin”

ls : hiển thị danh sách files và thư mục

man ls : xem cách dùng lệnh ls

cd bin : chuyển từ thư mục hiện tại sang thư mục “bin”

pwd : hiển thị thư mục hiện hành, để biết là mình hiện đang ở đâu

cd .. : chuyển từ thư mục hiện hành lên thư mục cấp trên

su : chuyển thành root (nhập root password)

passwd : thay đổi password (nhập password cũ và password mới)

7

QuanTriMang.com
http://www.QuanTriMang.com



uname -a : hiển thị tên và phiên bản của hệ điều hành

less foo.txt : hiển thị nội dung file foo.txt ra màn hình Terminal

cp foo.txt bar.txt : copy file foo.txt ra bar.txt

mv foo.txt hoge.txt : đổi tên file foo.txt thành hoge.txt

mv bin sbin : đổi tên folder bin thành sbin

rm foo.txt : xoá file foo.txt

rm -r bin : xoá thư mục bin

rm -rf * : Xoá tất cả mọi thứ ở thư mục hiện hành mà không cần xác nhận lại. Hết sức thận
trọng đối với lệnh này!

ln -s foo.txt bar.txt : tạo bar.txt links đến foo.txt

man command_name : đọc hướng dẫn chi tiết về các lệnh, nghĩa là gõ man theo sau bởi tên
lệnh.

Khi nhập tham số là những file có tên dài, chỉ việc nhập 1, 2 chữ đầu tiên và ấn phím Tab,
tên file sẽ tự động được hiển thị. Đây là tính năng hỗ trợ rất tiện lợi, vừa tránh được việc
gõ nhầm tên file, vừa giảm được rất nhiều công gõ bàn phím. Ví dụ khi muốn copy một file
có tên là some-file-with-very-long-name.txt thành file short-file.txt bạn chỉ cần gõ
cp so và nhấn phím Tab, tên file some-file... sẽ tự động được bổ sung. Bạn chỉ nhập thêm
short-file.txt là xong. Thủ thuật này sẽ phát huy tác dụng khi bạn thực hiện các phần
hướng dẫn sau.
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4 Nối mạng

Khi cài đặt, bạn đã để Lan card (eth0) theo chế độ “Active on Boot” và tự động nhận IP do
DHCP server của ISP (Internet Service Provider) cung cấp. Như vậy bạn nghiễm nhiên có thể
dùng được internet mà không cần cấu hình lại bất cứ cái gì khác. Để kiểm tra xem đã nối mạng
chưa, bạn dùng trình duyệt web Mozilla (nhấn vào icon hình quả địa cầu trên thanh công cụ
hoặc chọn Redhat → Internet → Web Browser), mở một trang web nào đó, ví dụ yahoo.com.
Nếu mở được trang này rồi thì bạn có thể bỏ qua phần “Nối mạng” này và đọc tiếp các phần
sau.

Phần sau đây hướng dẫn cách nối mạng qua đường broadband (xDSL) theo giao thức
PPPoE.

1. Đăng nhập với account ‘penguin’

2. Khởi động Terminal

3. Dùng lệng su để trở thành root

4. Dùng lệnh /sbin/adsl-setup

5. Phần LOGIN NAME: nhập tên user do nhà ISP cung cấp

6. Phần INTERFACE: để như mặc định (default eth0), nhấn Enter

7. Nó hỏi có muốn mình muốn nối mạng thường xuyên hay chỉ nối khi cần thiết, chọn ‘stay
up continuously’ bằng cách nhập ‘no’ và Enter

8. Phần DNS: Thông thường ISP để DNS là dynamic, nhập ‘server’ và Enter

9. Phần PASSWORD: Nhập password do ISP cung cấp

10. Phần USERCTRL: Nhập ‘yes’, Enter

11. Phần FIREWALLING: Nhập ‘1’, Enter

12. Tiếp theo nhập ‘yes’, Enter để máy tự động nối mạng mỗi lần khởi động

13. Cuối cùng nhập ‘y’ để save những thông tin vừa nhập

14. Dùng lệnh /sbin/ifup ppp0 để bắt đầu nối mạng

15. Dùng lệnh /sbin/adsl-status /etc/sysconfig/network-scripts/ifcfg-ppp0 để kiểm
tra xem đã nối mạng chưa.
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5 Cập nhật

Cập nhật các gói (packages) mới nhất là việc cần làm ngay. Để update, cách đơn giản nhất là
dùng tiện ích yum. Muốn biết chi tiết về cách dùng yum, gõ man yum.

1. Đăng nhập với account penguin, khởi động “Terminal”

2. Thực hiện lệnh su để trở thành root

3. Thực hiện lệnh yum update để chương trình yum tự động download và cài đặt những gói
mới nhất. Khi được hỏi có đồng ý hay không thì nhấn ‘y’, Enter

4. Bạn phải đợi từ 30 tới 45 phút để yum cập nhật mọi thứ.

Chú ý: Sau khi cập nhật, bạn khởi động lại hệ thống. Trong danh sách của boot loader (grub)
có thể tồn tại nhiều loại Linux với các phiên bản khác nhau. Đây là kết quả update kernel
(nhân của hệ điều hành) bởi yum. Bạn hãy chọn kernel mới nhất (có số version cao nhất). Sau
khi boot xong bạn có thể xoá bỏ những kernel cũ bằng tiện ích rpm.

5.1 RPM Package Manager

RPM là tiện ích rất tiện lợi để quản lý (build, install, query, verify, update, erase) các gói. Tính
dễ dùng của nó cũng là một yếu tố giúp cho Redhat Linux (Fedora) trở nên phổ cập và khác
biệt so với các phiên bản Linux khác. Muốn biết chi tiết về rpm, gõ man rpm. Sau đây là một
số cách dùng rpm cơ bản.

rpm -ivh foo.rpm : Cài đặt gói foo (đuôi file là rpm) vào hệ thống

rpm -Uvh foo.rpm : Update gói foo

rpm -qa | grep foo : Phối hợp giữa lệnh rpm và lệnh grep để tìm tất cả các gói liên quan
đến foo.

rpm -e foo : Xoá gói foo khỏi hệ thống
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6 Sử dụng

Muốn thực hiện các hướng dẫn trong phần này bạn phải có gói XMLinux.tbz, nếu chưa có,
bạn có thể download tại http://vcsj.net/xmlinux.tbz. Sau khi download bạn để gói này ở
/home/penguin, tức là ở ngay dưới thư mục mặc định mỗi lần khởi động “Terminal”. Tiếp đến
bạn dùng lệnh tar xvjf xmlinux.tbz để giải nén các files trong gói xmlinux. Giải nén xong bạn
cd xmlinux để di chuyển vào trong thư mục xmlinux. Từ đây cho tới hết phần hướng dẫn sử
dụng này, bạn thực hiện trên /home/penguin/xmlinux

6.1 Cài thêm fonts tiếng Việt và Unicode

Đi kèm với gói XMLinux có thư mục vi chứa các font cần thiết cho việc nhập và hiển thị tiếng
Việt cũng như Unicode, bao gồm: MS Arial, MS Tahoma, MS Times New Roman, MS Verdana,
VN Times (TCVN), VNI Times, VPS Côn Sơn (VPS), VI Times và UHoài 1.1 (VISCII), cộng
với 3 font thư pháp của VNI. Bạn chỉ việc copy cả thư mục vi vào /usr/share/fonts và thực
hiện lệnh fc-cache để cập nhật. Cụ thể làm như sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ su

Password:

[root@vcsj xmlinux]# cp -r vi /usr/share/fonts/

[root@vcsj xmlinux]# fc-cache /usr/share/fonts/vi/

[root@vcsj xmlinux]# exit

6.2 Nhập tiếng Việt bằng X-Unikey

Hiện nay phổ biến hai tiện ích nhập tiếng Việt trên Linux/Unix là xvnkb (Vietnam Keyboard
for X) của Đào Hải Lâm1 và X-Unikey của Phạm Kim Long2. Tùy thói quen và sở thích mà
bạn có thể chọn giữa xvnkb và x-unikey. Cả hai đều xuất sắc và hầu như đã giải quyết triệt
để các vấn đề bảng mã, cách nhập tiếng Việt. Tác giả bài viết này vốn quen dùng xvnkb nhưng
ở đây xin được giới thiệu x-unikey vì rất nhiều người dùng Windows đã quen với Unikey.

Để cài đặt X-Unikey, bạn có thể cài đặt bằng tiện ích rpm với gói rpm cho X-Unikey đã được
chuẩn bị sẵn bởi tác giả Nguyễn Đại Quý. Tuy vậy ở đây tôi sẽ hướng dẫn bạn cài X-Unikey
từ mã nguồn, qua đó hy vọng bạn sẽ phần nào hiểu được thế nào là mã nguồn mở. Bạn có thể
download mã nguồn của X-Unikey từ website ở trên hoặc có thể dùng luôn bản copy đi kèm
trong gói XMLinux. Cụ thể hãy làm như sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux

[penguin@vcsj xmlinux]$ tar xvjf x-unikey-0.9.1d.tar.bz2

[penguin@vcsj xmlinux]$ cd x-unikey-0.9.1d

[penguin@vcsj x-unikey-0.9.1d]$ ./configure

[penguin@vcsj x-unikey-0.9.1d]$ make

[penguin@vcsj x-unikey-0.9.1d]$ su

Password:

[root@vcsj x-unikey-0.9.1d]# make install

1http://xvnkb.sourceforge.net
2http://unikey.sourceforge.net
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[root@vcsj x-unikey-0.9.1d]# exit

exit

[penguin@vcsj x-unikey-0.9.1d]$ cd

[penguin@vcsj penguin]$ cat >> .bashrc

export LANG=en_US.UTF-8

export XMODIFIERS="@im=unikey"

export GTK_IM_MODULE="xim"

[penguin@vcsj penguin]$

Giải thích qua về các bước ở trên như sau: Đầu tiên bạn cd để trở về ~/. Sau đó bạn chuyển
đến thư mục xmlinux và giải nén gói x-unikey phiên bản 0.9.1d. Giải nén xong bạn được thư
mục x-unikey-0.9.1d, bạn cd tới đó và thực hiện lệnh ./configure. Lệnh này sẽ configure hệ
thống chuẩn bị cho bước sau. Bạn sẽ nhìn thấy hàng loạt ký tự khó hiểu được in ra màn hình
“Terminal”. Tốn vài ba giây để configure. Tiếp theo bạn thực hiện lệnh make để bắt đầu dịch
chương trình từ mã nguồn. Sau đó bạn su để trở thành root và thực hiện lệnh make install

để cài đặt các file đã biên dịch vào hệ thống. Xong phần này bạn đã nắm được quy trình cơ
bản để cài đặt các gói từ mã nguồn trên nền Unix/Linux.

Cài đặt xong, bạn có thể nhập exit và nhấn Enter hoặc đơn giản chỉ nhấn Ctrl-D để trở
thành người dùng bình thường. Cuối cùng bạn trở về ~/, sửa lại file .bashrc để từ lần khởi
động tới bạn có thể sử dụng X-Unikey. Bạn dùng lệnh cat >> .bashrc để ghi tất cả những
gì bạn sẽ nhập sau đó vào cuối file .bashrc hiện hành (các file bắt đầu bằng dấu . là file ẩn).
Nhập xong 3 dòng export... bạn thoát ra bằng cách nhấn Ctrl-C.

Bạn logout ra khỏi hệ thống và login trở lại, khởi động “Terminal”, nhập dòng lệnh unikey

để khởi động X-Unikey. Lần đầu tiên bạn có thể gặp một thông báo lỗi là “không thấy file
.unikeyrc”, bạn không cần phải lo gì bởi file này sẽ tự động được tạo ra nếu không tồn tại,
nghĩa là từ lần sau bạn sẽ không gặp lỗi này nữa.

Cách dùng X-Unikey thì chẳng khác gì Unikey trên Windows. Tôi quen dùng ở chế độ gõ
Telex, bảng mã Unicode (TX: UTF8). Muốn kiểm tra bạn có thể nhấn chuột vào icon của
X-Unikey phía dưới bên phải màn hình tới khi hiển thị ra TX:UTF8 sau đó hãy gõ tiếng Việt
vào ngay con trỏ của màn hình Terminal.

Muốn mở/tắt việc nhập tiếng Việt, bạn dùng tổ hợp phím Ctrl-Shift. Muốn tắt hẳn X-
Unikey bạn dùng lệnh kill ‘pidof unikey‘ hoặc logout ra ngoài, login trở lại (Thực ra thì
không cần kill unikey làm gì, chỉ cần Ctrl-Shift)

6.3 Duyệt web bằng Mozilla

Đi kèm với FC2 có Mozilla - trình duyệt Web rất được ưa chuộng và là giải pháp thay thế MS
Internet Explorer trong các vấn đề bảo mật. (Tuy nhiên gần đây Mozilla cũng đã trở thành
mục tiêu tấn công của mấy đứa rỗi hơi suốt ngày ngồi sản xuất virus với cả hack này nọ). Ngoài
Mozilla ra bạn còn các lựa chọn khác như Konqueror đi kèm với môi trường windows KDE,
hoặc Firefox - trình duyệt ưa chuộng của cá nhân tác giả bài viết này. Sau đây là cách sử dụng
Mozilla.

Bạn có thể nhấn chuột vào hình quả cầu trên thanh công cụ hoặc chọn Redhat → Internet
→ Web Browser để khởi động Mozilla. Mở một trang ví dụ như http://vnexpress.net để
... kiểm tra chất lượng. Muốn thay đổi font chữ bạn có thể vào mục Edit trên thanh công cụ
của Mozilla rồi từ đó chọn Preferences, Appearance, Fonts → thay đổi các font chữ mặc định
thành các loại font quen thuộc như Times New Roman, Verdana,... (Các font này đã được cài
đặt như hướng dẫn phía trên)
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Tiếp đến bạn cần cài plugin để duyệt các trang có sử dụng Java Applet hoặc Flash. Plugin
cho Java đi kèm với bản Java 2 SDK hoặc Java 2 JRE của Sun. Mặc dù chỉ cần cài Java 2 JRE
là đủ plugin cho Mozilla nhưng ở đây tôi hướng dẫn bạn cài Java 2 SDK vì nó cần dùng cho
việc lập trình Java sau này.

Bạn có thể vào Website của Sun download bản j2sdk cho Linux hoặc sử dụng luôn bản copy
đi kèm với XMLinux. (Tại thời điểm 19/7/2004, phiên bản mới nhất là j2sdk-1_4_2_05)

[penguin@vcsj xmlinux]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ su

Password:

[root@vcsj xmlinux]# mv j2sdk-1_4_2_05-linux-i586.bin /usr/local/

[root@vcsj xmlinux]# cd /usr/local/

[root@vcsj local]# chmod +x j2sdk-1_4_2_05-linux-i586.bin

[root@vcsj local]# ./j2sdk-1_4_2_05-linux-i586.bin

Nhấn Enter cho tới khi nào câu hỏi có đồng ý với license terms hay không, nhập yes. Sau
đó J2SDK sẽ được cài vào /usr/local/j2sdk1_4_2_05. Tiếp theo bạn xóa j2sdk-1_4_2_05-
linux-i586.bin và tạo một đường link tới j2sdk1_4_2_05 bằng lệnh:

[root@vcsj local]# rm -f j2sdk-1_4_2_05-linux-i586.bin

[root@vcsj local]# ln -s j2sdk1.4.2_05/ java

Cuối cùng tạo Java plugin cho Mozilla bằng lệnh sau:

[root@vcsj]# cd /usr/local/java/jre/plugin/i386/ns610/

[root@vcsj local]#ln -s libjavaplugin_oji.so /usr/lib/mozilla-1.6/plugins/

Đối với plugin cho Flash, bạn có thể download gói rpm cho FC2 tại http://ruslug.

rutgers.edu/macromedia/site_ru.html hoặc sử dụng luôn bản copy đi kèm với XMLinux.

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ su

Password:

[root@vcsj xmlinux]# rpm -ivh flash-plugin-7.0.25-1.i386.rpm

Như vậy bạn đã có thể lướt web cùng Mozilla với các chức năng Java Applet và Flash. Bạn
cũng có thể cài đặt plugin cho Firefox theo cách tương tự.

6.4 Liên lạc bằng Gaim

Gaim là tiện ích giống như Yahoo!Messenger nhưng hỗ trợ đồng thời nhiều giao thức khác
nhau. Bạn có thể dùng Gaim để liên lạc với bạn bè theo đủ các giao thức như: AIM, ICQ,
Yahoo!, MSN, Jabber, IRC, Napster, Gadu-Gadu và Zephyr. Bật X-Unikey lên bạn có thể chat
với bạn bè bằng tiếng Việt chuẩn mà không phải cấu hình gì.

Bạn khởi động Gaim bằng cách chọn Redhat→ Internet→ Gaim Internet Messenger. Cách
dùng thì xin được lược bỏ, bạn sẽ tốn không hơn 2 phút để có thể sử dụng Gaim.
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6.5 Nghe nhạc mp3 bằng xmms

Xmms là trình duyệt mp3 khá nổi tiếng trên nền X, có các tính năng giống như Winamp trên
Windows. xmms được kèm theo FC2 nhưng do một số vấn đề về bản quyền, xmms mặc định
không chơi được các file mp3. Phải sửa lại chút đỉnh.

Bạn có thể vào http://tettnang.freshrpms.net/rpm.html?id=296 để download gói xmms
mới hoặc dùng luôn bản copy đi kèm với XMLinux.

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ su

Password:

[root@vcsj xmlinux]# rpm -ivh xmms-mp3-1.2.10-2.2.p.1.fc2.fr.i386.rpm

Khởi động xmms bằng lệnh xmms&, sau đó nhấn chuột phải vào một vùng nào đó trên cửa sổ
xmms, chọn Options → Preferences. Trong phần Audio I/O Plugins nhấn chuột vào MPEG
Layer 1/2/3 Placeholder Plugin [lib_rhmp3.so] và gỡ bỏ lựa chọn Enable Plugin rồi Apply

Bạn có thể dùng lệnh xmms mp3_file để mở nghe mp3. Cách dùng xmms cụ thể xin được
lược bỏ vì nó không khác gì Winamp trên Windows cả.

6.6 Xem video bằng xine

Xine là trình duyệt video khá tốt với giao diện đẹp (http://xinehq.de). Cài xine rất đơn giản:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ su

Password:

[root@vcsj penguin]# yum install xine xine-skins

Ngoài xine ra bạn còn có nhiều lựa chọn khác, ví dụ như mplayer. Có thể xem hướng dẫn cách
cài mplayer của Bùi Minh Trường tại http://nhatban.net/modules.php?name=News&file=

article&sid=12

6.7 Sử dụng bộ Open Office

Open Office là bộ Office miễn phí với các tính năng soạn thảo văn bản Writer giống MS Word,
bảng tính Calc giống MS Excel, soạn phim trình chiếu Impress giống MS PowerPoint. Bạn có
thể dùng Open Office để làm việc với các công việc văn phòng dùng tiếng Anh, tiếng Nhật,
tiếng Việt... Open Office cũng tương thích với MS Office. Khởi động Open Office từ các icons
trên thanh công cụ hoặc chọn Redhat → Office → {Writer, Calc, Impress,...}

6.8 Soạn thảo văn bản bằng Emacs/Vim/gEdit

6.8.1 Emacs

Emacs là trình soạn thảo văn bản nổi tiếng bậc nhất trong thế giới Unix/Linux. Bạn có thể

tham khảo cách dùng Emacs qua hướng dẫn của Bùi Minh Trường3. Ở đây tôi chỉ hướng dẫn
một số cách dùng đơn giản.

Khởi động emacs bằng lệnh emacs foo.txt. Nếu trong thư mục hiện hành có file foo.txt

thì emacs sẽ mở file này, nếu không có thì emacs sẽ tạo ra file foo.txt mới. Sau khi đã mở
foo.txt, các lệnh sau thường được dùng:

3http://vcsj.net/modules.php?name=News&file=article&sid=8
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Ctrl-h : Hiển thị trợ giúp

Ctrl-k : Cắt từ vị trí con trỏ tới cuối dòng

Ctrl-w : Cắt toàn bộ đoạn văn bản đã được highlight

Ctrl-p : Dán text trong buffer vào vị trí con trỏ

Ctrl-d : Xóa một ký tự sau vị trí con trỏ

Ctrl-x u : Undo

Ctrl-x Ctrl-f : Tạo file mới hoặc mở file có sẵn

Ctrl-x Ctrl-s : Save file

Ctrl-x Ctrl-c : Đóng file, đóng chương trình emacs

Ctrl-s : Search pattern trong file

Esc-% : Thay thế pattern

Esc Ctrl-s : Thay thế kiểu biểu thức chính quy

Ctrl-g : Trở lại trạng thái chờ lệnh

Bằng cách kết hợp phím Ctrl và phím Esc (Escape), bạn có thể làm được mọi thứ trong Emacs.
Chú ý rằng Emacs không chỉ đơn thuần là trình soạn thảo văn bản mà còn dùng để đọc và gửi
email, đọc tin, phát triển phần mềm, v.v.

6.8.2 Vim

VIM (Vi IMproved) là chương trình soạn thảo văn bản phát triển từ VI, còn VI là chương trình
soạn thảo cổ điển và truyền thống của người dùng UNIX. Cái hay của Vim là tốc độ khởi động
cực nhanh, trong quá trình soạn thảo lại không tạo ra các bản backup đuôi ∼ giống Emacs.
Tác giả bài này thường dùng Vim trong hầu hết các công việc soạn thảo.

Cũng giống như Emacs, có rất nhiều hướng dẫn chi tiết về cách dùng VIM. Bạn có thể tham
khảo bài viết của Bùi Minh Trường4 hoặc bài viết của Hàn Thế Thành5. (Trong gói XMLinux
có kèm theo bản copy của vim-intro.pdf)

6.8.3 gEdit

gEdit là trình soạn thảo văn bản rất tiện lợi trên nền X. Khởi động gEdit bằng lệnh gedit

hoặc chọn Redhat→ Accessories→ Text Editor. Như mặc định, gEdit sẽ open và save văn bản
theo bảng mã Unicode (UTF-8). Muốn open hoặc save văn bản ở bảng mã khác bạn làm như
sau:

1. Mở gEdit

2. Chọn File → Save As

4http://vcsj.net/modules.php?name=News&file=article&sid=7
5http://vinux.sourceforge.net/vim-intro/vim-intro.pdf
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3. Trong cửa sổ “Save as...”, mục “Character Coding” chọn “Add or Remove...”. Từ cửa sổ
“Character codings” chọn loại encode từ cửa sổ bên trái và Add vào cửa sổ bên phải. Cuối
cùng nhấn OK. Tôi thêm Western ISO-8859-1 để có thể save các file khi soạn tiếng Việt
theo các bảng mã như TCVN, VISCII, VPS.

Khi soạn văn bản với bảng mã khác UTF-8, bạn cần chọn font thích hợp. Thay đổi font bằng
cách chọn Edit → Preferences. Chọn Fonts & Colors và lựa font thích hợp từ hộp Editor font.
Ví dụ, khi dùng bảng mã TCVN tôi chọn font .VnTime, khi dùng VISCII tôi chọn VI Times
hoặc UHoài 1.1, khi dùng VPS tôi chọn VPS Côn Sơn...

gEdit còn cung cấp nhiều plugin như kiểm tra chính tả, chọn ngôn ngữ, thống kê văn bản,
chạy command line,... Bạn có thể sử dụng các tính năng này bằng cách chọn Edit→ Preferences
rồi chọn tab Plugins, check những tính năng cần thiết rồi Close. Từ lần sau có thể dùng các
tính năng trên trong menu Tools.

6.9 Đồ hoạ bằng Gimp

Nếu trên Windows có Photoshop thì trên Unix/Linux có Gimp. Phiên bản mới nhất Gimp 2.0
cho phép bạn làm được tất cả những gì Photoshop có thể! Khởi động Gimp bằng cách gõ lệnh
gimp hoặc chọn Redhat → Graphics → GIMP Image Editor. Công việc còn lại thì phó mặc
cho sense nghệ thuật của bạn. Chú ý là có thể sử dụng tiếng Việt tốt trong Gimp.

6.10 Tạo ảnh vector bằng tgif

Để tạo các ảnh hình học dạng vector (trái ngược với ảnh raster như bitmap, jpeg, gif,...) bạn
dùng Tgif. Cài đặt Tgif rất đơn giản. Bạn vào http://bourbon.usc.edu:8001/tgif download
gói rpm Tgif hoặc có thể sử dụng luôn bản copy kèm theo XMLinux. Cài đặt theo cách sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ su

Password:

[root@vcsj xmlinux]# rpm -ivh tgif-4.1.43-1.i386.rpm

Khởi động Tgif bằng lệnh tgif. Vẽ hình xong có thể save file dạng EPS (Encapsulated
PostScript).

6.11 Vẽ biểu đồ bằng gnuplot

GNUPLOT là trình vẽ đồ thị bằng dòng lệnh cổ điển trên Unix/Linux. Bằng GNUPLOT bạn
có thể tạo ra các biểu đồ dạng vector chất lượng cao (để nhúng vào các file tex chẳng hạn).
Rất nhiều kỹ sư và nhà khoa học sử dụng GNUPLOT làm chương trình chính thức tạo biểu
đồ cho các báo cáo gửi hội nghị. Khởi động GNUPLOT bằng lệnh gnuplot. Sau đây là hướng
dẫn cách dùng cơ bản nhất.

1. Chuẩn bị một file dữ liệu tên là force.dat với nội dung như sau (file này có đi kèm
XMLinux). Save file này vào dưới thư mục xmlinux, thực hiện các lệnh dưới đây ở xmlinux.

# This file is called force.dat

# Force-Deflection data for a beam and a bar

# Deflection Col-Force Beam-Force
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0.000 0 0

0.001 104 51

0.002 202 101

0.003 298 148

0.0031 290 149

0.004 289 201

0.0041 291 209

0.005 310 250

0.010 311 260

0.020 280 240

2. Khởi động gnuplot (gõ lệnh gnuplot)

3. Từ prompt của gnuplot (dấu >), gõ splot -x**3 -y, tiếp theo gõ splot sin(x)*cos(y),
cuối cùng là plot sin(x) title ’Sine Function’, tan(x) title ’Tangent’. Bạn sẽ
thấy được sự tiện lợi của GNUPLOT khi vẽ các đồ thị toán học kiểu z = −x3 − y,
z = sin x cos y,...

4. Vẽ đồ thị từ dữ liệu chuẩn bị trước bằng lệnh

> set title "Force Deflection Data for a Beam and a Column"

> set xlabel "Deflection (meters)"

> set ylabel "Force (kN)"

> set key 0.01,100

> set label "Yield Point" at 0.003,260

> set arrow from 0.0028,250 to 0.003,280

> set xr [0.0:0.022]

> set yr [0:325]

> plot "force.dat" using 1:2 title ’Column’ with linespoints , \

"force.dat" using 1:3 title ’Beam’ with points

> set terminal postscript eps color

> set output "force.eps"

> replot

Bằng cách trên bạn có thể tạo ra được file force.eps với đồ thị như hình 1

Cách dùng GNUPLOT chi tiết bạn có thể tham khảo ở rất nhiều trang web. Chỉ cần vào
Google và search Gnuplot Tutorial

6.12 Xem file pdf bằng Acrobat Reader

Trong FC2 đã có những chương trình xem PDF rất tốt như ggv hoặc xpdf, tôi hướng dẫn thêm
cách dùng Acrobat Reader vì dẫu sao nó cũng quen thuộc, nhiều tính năng, và dễ dùng đối với
những bạn thường làm việc với Windows.

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ tar xvzf linux-508.tar.gz

[penguin@vcsj xmlinux]$ su

Password:

[penguin@vcsj xmlinux]# ./INSTALL
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Hình 1: Vẽ đồ thị bằng GNUPLOT

Nhấn Enter một hồi cho tới khi nó hỏi mình accept hay decline với các điều khoản sử dụng,
nhập accept và Enter. Nó sẽ hỏi mình có đồng ý cài vào /usr/local/Acrobat5 hay không,
đồng ý bằng cách nhấn Enter.
Tiếp theo phải cài thêm mấy font tiếng Nhật.

[root@vcsj xmlinux]# tar xvzf jpnfont5x.tar.gz

[root@vcsj xmlinux]# cd JPNKIT/

[root@vcsj JPNKIT]# ./INSTLANG

Khi được hỏi là có muốn Continue installation hay không thì trả lời có bằng cách nhấn Enter.
Tiếp đến nhập accept, Enter để chấp nhận điều kiện sử dụng. Lại nhấn Enter tiếp khi được
hỏi về chỗ cài đặt.
Vẫn chưa xong.

[root@vcsj JPNKIT]# cd ..

[root@vcsj xmlinux]# tar xvzf jpnfont4x.tar.gz

[root@vcsj xmlinux]# cd JPNKIT/

[root@vcsj JPNKIT]# tar xvf LANGJPN.TAR

[root@vcsj JPNKIT]# mv CIDFont/Heisei* /usr/local/Acrobat5/Resource/Font/

Cuối cùng là tạo một đường link tới acrobat để tiện việc khởi động.

[root@vcsj JPNKIT]# ln -s /usr/local/Acrobat5/bin/acroread /usr/bin/acroread

Từ nay có thể dùng Acrobat Reader bằng cách gõ lệnh acroread foo.pdf, nghĩa là dùng
Acrobat Reader để xem file foo.pdf

6.13 Lập trình C/C++ bằng gcc

Gcc (GNU Compiler Collection) là một tập hợp các thư viện (glibc, libgcc, ...), preprocessor
(cpp0), assembler (as), compiler (cc1), linker (collect2 or /usr/bin/ld),... dùng để phát triển

các chương trình C/C++. Gcc thậm chí còn hỗ trợ cả Java cũng như một số ngôn ngữ khác. Ở
đây tôi chỉ trình bày cách dùng sơ đẳng nhất để biên dịch và chạy một chương trình C/C++
trên Linux.
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6.13.1 C

Dùng Emacs, Vim, hoặc gEdit soạn một file tên là hello.c như sau, save vào thư mục
~/xmlinux:

#include <stdio.h>

main() {

printf("Xin chao C!\n");

}

Tiếp theo bạn biên dịch file hello.c và chạy thử như sau:

[penguin@vcsj xmlinux]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ cc hello.c

[penguin@vcsj xmlinux]$ ./a.out

Xin chao C!

[penguin@vcsj xmlinux]$

Bạn có thể thay lệnh cc bằng lệnh gcc vì thực tế thì cc chỉ là một link của gcc. Bạn dùng
gcc (hay cc) để biên dịch các file C. Theo mặc định output file sẽ là một file executable tên là
a.out. Muốn tạo ra file khác bạn thêm option -o file_name vào như sau

[penguin@vcsj xmlinux]$ cc -o hello hello.c

[penguin@vcsj xmlinux]$ ./hello

Xin chao C!

[penguin@vcsj xmlinux]$

6.13.2 C++

Dùng Emacs, Vim, hoặc gEdit soạn một file tên là hello.cpp như sau, save vào thư mục
~/xmlinux:

#include <iostream>

using namespace std;

main() {

cout << "Hello C++!\n";

}

Tiếp theo bạn biên dịch file hello.cpp và chạy thử như sau:

[penguin@vcsj xmlinux]$ cd

[penguin@vcsj penguin]$ cd xmlinux/

[penguin@vcsj xmlinux]$ g++ -o hi hello.cpp

[penguin@vcsj xmlinux]$ ./hi

Hello C++!

[penguin@vcsj xmlinux]$

Bạn chú ý, dùng g++ để biên dịch các file C++.
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6.14 Lập trình Java bằng Sun J2SDK

Java là mốt thời thượng hiện nay! Hầu hết các công ty sản xuất phần mềm của Nhật đều dùng
Java như một ngôn ngữ chính. Bạn có thể xin được việc làm về IT dễ dàng nếu sử dụng được
Java. Phần này hướng dẫn những thao tác cơ bản để bắt đầu tu luyện thứ ngôn ngữ hiện đại
và siêu mạnh này.

Trong phần cài plugin cho Mozilla bạn đã cài J2SDK vào thư mục /usr/local/java. Bạn
cần chỉnh sửa một chút để có thể biên dịch và chạy các file java. Trước hết cần thêm vào biến
môi trường PATH đường dẫn đến bin của java.

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ su

Password:

[root@vcsj penguin]# cat >> /etc/profile

PATH=/usr/local/java/bin:$PATH

export PATH

[root@vcsj penguin]# exit

[penguin@vcsj penguin]$ source /etc/profile

[penguin@vcsj penguin]$

Nhập xong dòng export PATH bạn nhấn Ctrl-C để kết thúc việc biên soạn file /etc/profile,
tiếp đó nhấn Ctrl-D để trở lại làm “penguin”. Bạn thực hiện lệnh source /etc/profile để
phản ánh những thay đổi đối với file /etc/profile. Để kiểm tra xem Java có được cài đặt
chuẩn hay không bạn gõ java -version để được kết quả tương tự như sau (với số version mới
hơn):

[penguin@vcsj penguin]$ java -version

java version "1.4.2_03"

Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.2_03-b02)

Java HotSpot(TM) Client VM (build 1.4.2_03-b02, mixed mode)

[penguin@vcsj penguin]$

Tiếp theo bạn chuẩn bị một file tên là Hello.java (chữ H viết hoa) và save ở thư mục ~/ (tức
là /home/penguin/)

class Hello {

public static void main (String args[]) {

System.out.println("Hello Java!");

}

}

Biên dịch và chạy thử file trên như sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ javac Hello.java

[penguin@vcsj penguin]$ java Hello

Hello Java!

[penguin@vcsj penguin]$
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Xem trong thư mục hiện hành (bằng lệnh ls) bạn sẽ thấy một file Hello.class được tạo ra.
Đó chính là class file của Java. Bạn dùng lệnh java class_file để chạy chương trình (có thể
lược bỏ đuôi .class). Chú ý thêm là tên file (không có đuôi .java) phải giống tên class!. Ví dụ
nếu bạn tạo một class là Hello thì tên file phải là Hello.java.

Khi biên dịch, javac (Java Compiler) tham chiếu biến môi trường CLASSPATH để tìm các
thư viện (thực chất là tập hợp những file *.class đã được biên dịch sẵn thành các gói và được

nén dưới dạng *.jar). Ở ví dụ trên, bạn không tham chiếu một thư viện nào nên không cần chỉ
định classpath, tuy vậy, trong những ứng dụng Java phức tạp hơn một chút, CLASSPATH là
không thể thiếu. Cách đơn giản nhất là tạo biến môi trường CLASSPATH trỏ đến các thư viện
(*.jar) đi theo J2SDK. Làm như sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ su

Password:

[root@vcsj penguin]# cat >> /etc/profile

JAVA_HOME=/usr/local/java

CLASSPATH=./:$JAVA_HOME/lib/tools.jar:$JAVA_HOME/jre/lib/rt.jar

export JAVA_HOME CLASSPATH

[root@vcsj penguin]# exit

[penguin@vcsj penguin]$ source /etc/profile

[penguin@vcsj penguin]$

Bạn có thể chỉ định đường dẫn đến thư viện cần tham chiếu bằng cách thêm tham số -classpath

vào dòng lệnh của javac. Thực hiện lệnh man javac để biết cách dùng javac.

Phần dưới đây hướng dẫn chi tiết hơn về cách viết package, cách biên dịch...
Giả sử bạn muốn viết một thư viện của riêng mình, tên là mylib.jar trong đó có 2 lớp là

Foo và Bar. Sau đó bạn viết một ứng dụng Java tên là Hoge.java tham chiếu đến thư viện
mylib.jar.

Trước tiên, tại thư mục ~/ tạo 2 file Foo.java, Bar.java như sau:

/* List of Foo.java */

package mylib;

public class Foo {

int i = 100;

public void display() {

System.out.println("Foo! i = " + i);

}

}

/* End of Foo.java */

/* List of Bar.java */

package mylib;
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public class Bar {

int i = 10;

public void display() {

System.out.println("Bar! i = " + i);

}

}

/* End of Bar.java */

Bạn biên dịch cả hai như sau:

javac -d . Foo.java Bar.java

Bạn dùng tham chiếu -d để chỉ ra địa điểm nơi package sẽ được tạo (là thư mục hiện hành,
thể hiện bằng dấu .). Sau lệnh này, tại thư mục hiện hành sẽ có thư mục mylib được tạo ra
bên trong chứa hai files: Foo.class và Bar.class. Bạn dùng lệnh tiếp theo để nén thư mục này
thành gói mylib.jar

jar cvf mylib.jar mylib/

Tiếp theo bạn viết một đoạn chương trình mới mà trong đó có sử dụng các lớp của thư viện
mylib. Chuẩn bị file Hoge.java như sau:

/* List of Hoge.java */

import mylib.*;

public class Hoge {

public static void main (String args[]) {

Foo f = new Foo();

f.display();

Bar b = new Bar();

b.display();

}

}

/* End of Hoge.java */

Bạn biên dịch file Hoge.java này như sau:

[penguin@vcsj penguin]$ cd

[penguin@vcsj penguin]$ javac -classpath mylib.jar Hoge.java

[penguin@vcsj penguin]$ java Hoge

Foo! i = 100

Bar! i = 10

[penguin@vcsj penguin]$

Thật dễ dàng đúng không ạ? Bạn đã biết cách tạo các class, cách tạo package (library), cách
dùng library, cách biên dịch, cách thực thi. Từ đây bạn đã có thể bắt đầu Java. Vào trang web
của Sun tại http://sun.com đọc tutorial. Bản thân tác giả bài viết này cũng mới trở thành
fan của Java và hiện đang “cảm động” vì những gì Java làm được. Có thể học hỏi các lập trình
viên Java người Việt tại http://www.javavietnam.org.
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